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1. Introduction

The rules and regulations of the second cycle of studies at the University of New York,
Tirana (from now on UNYT) define the rights and obligations that are created between
the  subjects  involved  in  the  master  thesis,  the  rules  for  organizing  the  writing  and
defense process, as well as their relations with the governing bodies and other structures
in the core unit (Department) and a main unit (Faculty) of the University of New York,
Tirana. This manual aims to provide the necessary framework for the smooth running of
the master  thesis  writing and defense process  and to  provide the same rules  for  the
organization of the process from an academic and administrative point of view.

2.Writing a master thesis

The successful completion of a master's thesis is a prerequisite for completion of the
master's program and acquisition of the master's degree. The main objective of this thesis
is to choose a specific problem and solve it using scientific literature (and/or empirical
findings).  By  writing  a  thesis  you  demonstrate  that  you  have  understood  important
theoretical contexts and methods and are capable of analyzing a particular problem, as
well  as  understanding  the  results  of  your  analysis  and  providing
recommendations/solutions about the phenomena/problem.  

2.1. Master Thesis Prerequisites

Master of Science in Psychology: To be registered and start working on a master's thesis
topic, a student needs to complete all the courses of his/her program. 

Master of Science in International Relations: To be registered and start working on a
master's thesis topic, a student needs to complete all the courses, except one (failure or
incomplete), of his/her program. 

2.2. Choice of Topic

The choice of topic is a very important point. You should choose a topic in collaboration
with your supervisor and that is of interest to you. It may be an issue that you have
always wanted to tackle, or possibly a current problem you were confronted with during
your studies.

2.2.1. Choosing a Topic 

When choosing a topic, please keep the following criteria in mind:
• The topic should arouse your interest and curiosity.
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• Ideally, the project will be of practical relevance and refer to recent developments.
• The sources used should be easy to locate and easily accessible.
• The topic should be within your supervisor’s area of expertise.

2.2.2. Broad or Narrow Topics

A piece of advice from the Humanities Faculty of Stanford University that can be applied to
all topics:

For example, the subject of geology is too broad. Vulcanology, as a branch
of geology, is still too broad. Mexico’s volcanoes could form a sensible, if
somewhat  superficial  paper.  Further  delimitation  would  lead  to  a  more
valuable  analysis: The history of Popocatepetl (which one of Cortez’
conquistadors probably climbed in 1519 and which only violently erupted
in 1702). Another concise subject that spans a lesser time period would be:
the eruption and  the apparent extinction  of  Paricutim  (from February

20th 1943 until March 4th 1952). (Cooper & Robins, 1967, p. 3; cited by
Eco, 1998, p. 18)

2.2.2.1. Arguments against choosing a broad topic

• You will soon find that there is too much literature and material available.
• It will be difficult to decide what is relevant and what is superfluous (risk of reading 

and citing the wrong sources).
• Research will be very time-consuming due to the lack of focus.
• The bachelor graduation project will be extremely long.

2.2.2.2. Arguments in favor of choosing a narrow topic

• The available literature/material is acceptably sufficient.
• The author can conduct a thorough review of the relevant research and literature.
• The author becomes an expert in a narrow, precise area, which may be an advantage 

when dealing with his/her supervisor.
• The graduation project will be clearer and more concise.

2.2.2.2.1. Acceptable Dissertation Themes and Topics

In preparation it will be helpful to ask yourself the following questions:

- Why is this issue relevant?
- What has already been written about the topic?
- Is there a gap in knowledge?
- Can the gap be filled by research?
- Is the research feasible within the confines of a Masters dissertation?

Once you have identified a possible topic, you need to consider the data you need to access.

- What kind of data do you need?
- How can you collect it?
- What difficulties are there likely to be?
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Some potential topics may be rejected because of the problems of data collection and you
need to identify this at an early stage.

2.2.2.2.2. Focusing and Formulating your Topic

By now it must be obvious that there is no uniform way of specifying what your dissertation
should be about, or how it should be approached.  A good dissertation usually has a clear
focus,  an interesting and perhaps even novel  approach,  and is  executed in  a  logical  and
convincing way.  To secure a positive outcome, it is worth expending some significant effort
on the preparatory and often uncomfortable processes of:

- specifying a prime focus which interests you;
- considering various alternative or complementary ways of tackling the issues;
- developing your ideas in a comprehensible way (i.e. comprehensible to someone other

than you).

One way of proceeding is to prepare a Thesis Proposal for each and every topic that appeals
to you. (An outline and checklist for such a document is shown in Appendix 4.)  The research
and writing process is messy at the best of times, so it makes sense to sort out in advance the
dissertation’s  purpose,  structure  and schedule.   This  will  also  provide  a  standard against
which you can judge your own progress.

The planned dissertation should therefore be:

- clearly focussed
- practicable and manageable,
- relevant,
- challenging but achievable.

2.2.3. Submission of the Master Thesis Topic

The form used to submit the Master Thesis topic to the supervisor needs to include the 
following information:

1. Name of the student
2. Student ID number(s)
3. Study program
4. Working title 
5. Description of the thesis
6. Signature of student
7. Signature of the supervisor 

The supervisor will inform you of the confirmation/changes in your topic and supervision.
Once both are confirmed, the supervisor will set a deadline for submission of the research
drafts. 

2.3. Procedure for Writing a Master Thesis

2.3.1. Establishing Contact
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Following the  assignment  of  the  supervisor  by the  Program Director,  the  supervisor
establishes contact with the student under supervision. In collaboration and under the
guidance  of  the  supervisor  the  students  choose  a  topic  for  the  thesis  and  prepare  a
proposal. The proposed topic will be discussed during the initial contact between the
student  and  the  supervisor  and  then  approved  by  the  supervisor  and  laid  out  in  a
manageable format.

2.3.2. Change of Master Thesis

A change of master thesis topic after submission of approval from the supervisor requires
the re-approval of the supervisor  and,  in  case  of  considerable  changes,  a  renewed
approval by the Program Director. 
In case of a negative assessment of a submitted thesis, the supervisor may ask the student
to make changes to the original topic.

2.3.3. Length of the Master Thesis

The Master thesis will be written and submitted by one student only. The student must
write a minimum of 15000 words excluding references and coverpage. 

2.3.4. Language of Master Thesis

The Master Thesis must be written in the English language. Special attention must be
paid to linguistic accuracy and appropriate style. For this purpose, it is advisable to use
the services of the Writing Centre, if it is needed.

2.3.5. Termination of Supervision 

If no substantial progress has been made and/or if a student fails to comply with the
deadlines set out by the supervisor, then the supervisor may terminate the supervision
and the student needs to be assigned to another supervisor by the Program Director as
well  as  needs  to  extent  the  time  of  the  completion  of  the  master  thesis.  All
communication of involved parties should be processed officially and in transparency. 
If  the  termination  of  the  supervision  is  processed  by  the  student,  he/she  needs  to
communicate it officially and state the reason behind it.

3. Researching and Writing the Master Thesis

If the student(s) choose to solve a specific problem using empirical findings (based on
data collected from human subjects and/or organizations), details about the instrument
(e.g.,  questionnaire  and/or  interview guideline),  data  collection method (e.g.,  how to
distribute the questionnaire)  and data analysis  method have to be discussed with the
supervisor before the implementation. If the student(s) needs to collect data from human
subjects, the supervisor has to send the drafted questionnaire and/or interview guidelines
to the Ethics Committee for approval.

If the student(s) choose to solve a specific problem using scientific literature, the most
important data source is the literature already published on the topic. Apart from the
information taken from books and periodicals, specialist magazines can also be used as
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sources. A wide variety of books and journals are available in the UNYT’s Library. 

3.1. What Makes a Good Master Thesis?

• The author identifies an interesting research problem, defines it clearly, and states its 
(practical) relevance.

• The author illustrates how the problem is gradually solved in a clear, comprehensive, 
and persuasive manner throughout the thesis. 

• The author makes a clear connection between the practical problem and theory (i.e., 
there is a genuine connection between theory and practice).

• The results are evident and are discussed accurately.
• The thesis is well-rounded, meaning that it does not address superfluous tangents but 

presents a clear line of argumentation.
• The thesis is formally correct in terms of language and grammar, citation standards, 

bibliography, and layout.

Students are advised to have their thesis critiqued by another person regularly. For this
purpose, discussions with the supervisor will be especially useful.

For the master  thesis,  it  does not  suffice to provide a mere list  of  various literature
sources one after the other. Rather, the sources must be critically incorporated into the
paper and be independently processed and interconnected. The supervisor will provide
support and help to improve the thesis with constructive criticism, advice, and assistance.

Upon completion, the linguistically (i.e., grammatically, and orthographically) flawless
master thesis must be submitted to the supervisor for assessment.

3.2. Submitting and assessing the Master Thesis
 

3.2.1. Submission 

The submission date of the master thesis is set according to the academic calendar of
UNYT, into which defense seminars and graduation are announced. The master thesis
must be submitted and receive a passing grade before graduation is possible.

The following documents are to be submitted to the supervisor:
 An  electronic  copy  of  the  master  thesis  (unless  stated  otherwise  by  the

supervisor),  along  with  a  written statement (affidavit) from the student
confirming that he/she wrote the paper independently and did not use resources
or aids other than those cited in the thesis. 

3.2.2. Master thesis assessment and defense

At the end of the writing process, the master thesis is evaluated by the supervisor and
Defense  Committee  members  in  an assessment  report  including an originality  report
from Turnitin. 

The assessment criteria  and their  respective weightings for  the Master  of  Science in
Psychology are as follows:

 Aim and Methodology 20%
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 Literature Review 20%
 Findings 30%
 Recommendations & Bibliography: 20%
 Overall format: 10%

The assessment criteria  and their  respective weightings for  the Master  of  Science in
International Relations are as follows:

 Overall assessment: 20%
 Argumentation: 20%
 Structure and Methodology: 20%
 Language: 20%
 Style:  20%

Students are requested to defend their thesis in front of a Thesis Committee composed of
the lead supervisor and two other professors. The defense is a public event, therefore
other  professors  and  students  are  invited  to  participate.  Each  of  the  three  Thesis
Committee Members submits an independent evaluation for the thesis. The final thesis
grade is is an average score of the three independently submitted at the Records. 90% of
the final thesis grade is awarded upon the final thesis draft and 10% of the grade is
awarded upon the student’s performance in the oral defense.

3.3. Rewriting the Master Thesis

The master's thesis is considered the final successful step to fulfill the requirements for
obtaining the master's diploma.  
Failing to:

a. follow the schedule of activities as arranged with the supervisor,
b. submit the thesis within the deadline,
c. submit the thesis of sufficient quality,
d. defending the thesis before the Committee 

will result in failing to complete the master thesis as an obligation to complete the second
cycle study program. In this case, the student needs to follow again the process according
to the guidelines of the supervisor,  or the requirements of the Committee during the
defense process. 

The thesis has to be rewritten if it receives a failing grade (including cases of proven
academic misconduct) and can be re-defended in the upcoming defense session set in the
academic calendar. 

3.4. Description of Roles Assigned to Supervisor and Author

The roles of the the student and supervisor of a master thesis can be described as follows:

3.4.1. The Student’s Tasks

The student alone is responsible for the master thesis. Apart from the main content-related 
work, this responsibility includes timely completion and conformity to the rules of 
academic honesty:

• Identifying and delimiting the topic
• Showing initiative when dealing with management (requesting 
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supervision, proposing a topic, making appointments, etc.)
• Searching for academic sources
• Developing a research design and conducting the research
• Writing the thesis in accordance with academic writing standards
• Reaching an agreement with the supervisor on important issues
• Incorporating feedback and receiving further criticism.

3.4.2. The Supervisor’s Tasks

The role of the supervisor is that of a mentor. The supervisor assists the author in the
process of writing a thesis and offers advice and assistance, such as:

• Providing constructive feedback on the content of the thesis
• Giving support in the face of problems, decisions, etc.
• Answering questions
• Evaluating the thesis by means of a detailed assessment report.

To enable this process, the author and the supervisor should schedule meetings in which
they review progress, discuss any problems that have emerged, and plan the next steps.
The  supervisor  may  keep   a  record  of  the  details  (time,  duration,  points  discussed,
activities agreed on) to document his/her role in the process and the student’s research
progress. In addition to the meetings, the supervisor will make him/herself available to
answer inquiries by phone or e-mail within reason.
The supervisor will read the research proposal, review the table of contents, and check
the appropriateness of sources. However, he/she is not required to read the thesis (or
parts of it) and provide feedback before submission.

3.5. Organization and Structure

Coherently structuring the master thesis is of paramount importance. The outline in 
Appendix 1 provides how one could structure the master thesis.

• Cover Sheet (see master thesis template in Appendix 1)
• Copyright page
• Approval sheet
• Dedication
• Table of Contents
• List of Figures
• List of Tables
• List of Abbreviations
• Acknowledgments
• Publications (optional)
• Field of Study (optional)
• Abstract of the thesis 
• Chapter 1: Introduction and Aims
• Chapter 2: Methodology 
• Chapter 3: Discussion of Relevant Literature
• Chapter 4: Methodology 
• Chapter 5: Results and analysis
• Chapter 6: Interpretation, Discussion, Conclusions and Policy Reccomendations
• Chapter 7: References
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• Appendixes: Statistics, Reports, Tables, Graphs etc.

3.6. Linguistic Accuracy and Clarity

The thesis must be written properly and appropriately in terms of grammar, punctuation,
spelling and the language used. When writing it, the student should use prosaic, objective
wording, and pay special attention to clarity. “Academic” is by no means equivalent to
“incomprehensible.” The more complex the subject matter is, the more important it is to
express oneself clearly.

3.6.1. Abbreviations

Abbreviations should be used sparingly and with deliberation. Saving space is rarely
justified when it comes to the cost of readability. Abbreviations should only be used in
cases where they are the norm in a particular case. This can save a considerable amount
of space and eliminate awkward repetitions.
Abbreviations of commonly used expressions can be used without an explanatory note.
For ambiguous or less commonly used abbreviations, it is certainly helpful to accompany
them  with  an  explanation  upon  their  introduction.  All  other  abbreviations  must  be
introduced before their initial use in the text. In other words, you should use the full form
of the abbreviated expression then indicate the abbreviation in parentheses. After this
initial introduction, the abbreviation can be used on its own.
A list of abbreviations must be inserted at the beginning of the thesis after as described
above.

3.7. Layout

• Submit the master thesis on A4 paper (double-sided printing).
• Use line spacing 2 in running text.
• Use the following fonts and font sizes: New Roman (10-12 pt).
• Include a margin of approximately 4 cm on the left-hand side of the page.
• Number each page consecutively.

3.8. Formatting

The following guidelines will be useful in the process of formatting your graduation project.

3.8.1. Headings and Running Text

Headings  serve  to  structure  a  text  and reflect  the  importance  of  individual  sections.
Different  levels  of  structure  must  be  indicated  by  different  heading  levels.
Paragraphs/sections that are of equal importance should receive headings of the same
level. Please consult the Appendix 1 for detailed formatting. 

3.8.2. Footnotes

Citations in footnotes are primarily found in German-speaking countries, whereas in-text
citations  –  also  known as the Harvard referencing system (see below) – are more
common internationally. Both variants have their advantages, and most supervisors will
leave this decision to you. In either case, brief remarks/comments,  amendments  to
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content, and cross-references should be placed in the footnotes.

3.8.3. Appendices

Appendices contain material that is too long to be included in the text or would interrupt
the flow of the presentation if  it  were cited in detail.  Such texts  include minutes of
meetings, questionnaires, interview outlines/records and the like. In the running text, you
should refer to material in your appendices with the word “Appendix” and consecutive
capital letters beginning with “A” (e.g., “see Appendix B”). Each appendix must begin
on a new sheet.

3.8.4. Figures and Tables

Figures (i.e., illustrations, diagrams, charts, graphs, etc.) and tables are used to give a
compact overview of material. Each figure and table is an integral component of the
paper  and  should  be  presented  in  a  uniform  manner, especially with regard to
descriptions, structure, format and labels. The following points are especially important
in the context of figures and tables:

 Each figure and table must also be interpreted/discussed, meaning that the core
information must be presented in the text.

 Wherever a figure or table is interpreted in the text, it  must be referred to clearly,
for example by writing “see Figure 2” or a similar reference.

 Every figure and table must  be understandable on its  own. For this  reason,  all
abbreviations (apart from the usual statistical abbreviations) must be explained, and
the unit(s) of measurement stated.

 Every graduation project must include separate lists of figures and tables. These are
to be inserted at the beginning of the paper after the table of contents. The number,
title and page number must be indicated for each item in these lists.

Longer figures and tables as well as those whose content is not necessarily discussed in
the text (e.g., because the figure fills up an entire page but only two values are mentioned
in the text) can be placed in the appendix.

3.8.5. Numbering

All figures and tables must be assigned consecutive numbers which reflect the order in
which  they  appear  in  the  graduation  project.  Use  Arabic  numerals  for  this  purpose.
Figures are to be numbered separately from tables. Depending on the style guide used,
students may want to number charts and diagrams separately and provide separate lists
of charts and diagrams (in lieu of a list of figures) at the beginning of the graduation
project.

3.8.6. Titles

Each figure and table should have a succinct and descriptive title.

3.8.7. Use of Word Processing Functions

Today’s word processing programs make it possible to create captions for figures and
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tables. This can be done using the “References” tab > “Insert Caption” button in Word.
The figures and tables are then numbered automatically. In addition, this function makes
it very easy to compile lists of figures and tables automatically.  Cross-references  to
figures and tables can also be inserted using the “Insert” tab > “Cross-reference” button.
If the sequence of figures or tables is changed at a later stage, the cross-references will be
updated automatically.

3.9.  Citation of Sources

3.9.1. Plagiarism

In order to foster academic honesty and maintain a high level of quality, UNYT has
issued a brochure clarifying its policy on plagiarism through its Code of Ethics. 

Any thesis  will  almost  inevitably  be  built  on  the  work  of  other  authors.  Otherwise,
academic progress would be unthinkable; one would have to “reinvent the wheel” every
time. 
However, there are clear  rules as to how one should handle other people’s ideas,
findings, and words. One of the most important standards is the correct citation of any
ideas developed by others and used as a basis for a paper. Students who a) employ the
“copy and paste” strategy and simply copy a paper (or parts of it) from the Internet; b)
incorporate  ideas  or  translations  from  foreign-language  texts  without  citing  those
sources; or c) pass another person’s work off as their own in any other way (e.g., by
using a “ghost writer”)  clearly violate these standards. Such violations are summarized
under the concept of plagiarism. Plagiarism generally refers to the deliberate or accidental
appropriation of other people’s words and/or ideas (i.e., passing someone else’s work off as
your  own),  which is  a  clear  violation of  academic standards.  In  many cases,  it  also
violates copyright regulations, which is a punishable offense (Höllerer and Kloibhofer
2006, p. 60f.).

For further information on the consequences of plagiarism, see UNYT Code of Ethics. 

To identify cases of plagiarism as such, a cursory glance at the related literature or simple 
research using an online search engine or database often suffices. Stylistic changes, 
especially to elaborate concepts, or statements that lack relevance to the problem at hand 
are usually obvious to lecturers and supervisors, and those are generally the first signs of 
plagiarism and/or copying. 

In  addition,  many universities  already use special  software which makes it  easier  to
detect  cases  of  plagiarism.  Of  course,  it  is  not  always  easy  to  determine where the
adoption of external ideas stops and one’s work begins. Writing an independent thesis is
certainly not an easy task. In the process, you must remember that the essence of your
work is not to seek out information but rather to carry out an independent analysis of
content related to the research issue at hand, to show that you have understood it, and to
demonstrate how it is applicable. 

If you take the aforementioned ideas and advice to heart, you will be able to deal with
this task with ease – without any copying (Höllerer and Kloibhofer 2006, p. 60f.).

3.9.2. Text Citation: Source Data
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Direct quotes are always reproduced verbatim and placed in quotation marks. As a
general rule, longer quotes (if absolutely necessary) are formatted differently for better
accentuation, often indented on both sides and preceded by a colon. Citations are also
required for paraphrases, summaries and indirect references because they involve the use
of an external body of thought. The use of another person’s words or ideas (in any
form) without acknowledgement/citation is plagiarism (see above).

The  American  Psychological  Association  (known  as  APA  Style;
http://www.apastyle.org) will be used as a citation style in this thesis. 

3.10.  References

The references at the end of the thesis contain essential information for the reader so that
he/she can identify the sources cited and find them in a library. Only those works that are
cited in the text can be included in the references. Each source referenced in the text
must  be  listed  in  the  references  and  vice  versa.  Therefore,  students  must  carefully
examine whether each reference is presented in both places and ensure that the source
cited in the text corresponds to its presentation in the references. Works are to be cited in
alphabetical order (by author’s last name) in the references, using APA style.

Appendix 1: Sample Master Thesis template

UNIVERSITY OF NEW YORK TIRANA

Thesis Title

A Thesis submitted in partial satisfaction of the requirements 
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for the degree Master of Science in …………..

in 

Degree title (major)

by

Name

Committee in charge:

Professor First Last, Chair/Co-Chair (select correct title)
Professor First Last, Co-Chair (if applicable)
Professor First Last

Note: Committee members need to be listed in alphabetical order by last name. Include the 
“Professor” title if all committee members are Professors.  If they are not all professors, then 
there are no titles.

2024
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Copyright / © (select one)

Name, 2024

All rights reserved.

THESIS APPROVAL PAGE

The Thesis of Name is approved, and it is acceptable in quality and form for
publication on microfilm and electronically.
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University of New York Tirana

2024

DEDICATION (optional)

Any format for justification, spacing, writing style, text size and text font is 

acceptable for this page, however, all text must fit within the 1-inch page margins. If you 

choose to have an Epigraph page, any formatting is also acceptable for that page.
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Appendix 1: Sample Master Thesis template...............................................................................13

Note: The “Thesis Approval Page” header is in white on page iii, so that the header does not 
appear on the page itself but appears in the Table of Contents. Do not delete this text.
Delete any Table of Contents entries that you are not using, like Dedication, List of 
Abbreviations, etc.

How to use the headers to auto-populate the Table of Contents: 
1. Use Heading Level 1 for any Chapter titles.  This must be used if you want to auto-

populate the chapter number in figures/tables.
Use Heading Level 2 for any preliminary page headers (like List of Figures, Vita, 
etc).
Use Heading Level 3 for any chapter headers. Levels 4-9 can be used for sub-headers,
but only Headings 1-3 will appear in the Table of Contents.

2. To choose the Heading Level: highlight the text you want listed as a header, then go 
to References Tab > Add Text > Level 1. Or go to the Home Tab and go to “Styles” 
and choose the Heading level.

3. To update the table, go to References Tab > Update Table near the Table of Contents.
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LIST OF FIGURES

Figure 1.1: Figure caption example. Figure captions go below figures................................................25
Figure 2.2: Figure caption example. Figure captions go below figures................................................26

How to: 
1. The List of Figures is created with the Table of Figures feature and the “Insert 

Caption” button. 

2. When inserting a caption for a figure, go to References Tab > Insert Caption. Be sure 
to choose the label “Figure”. This will pull the caption into the List of Figures. The 
chapter numbers should automatically generate as long as you use the Headings as 
instructed.

3. To update the List of Figures, click on the figure captions above, then click “Update 
Table” near the Insert Caption button.

4. To update the Table of Contents, List of Figures, and List of Tables at the same time: 
press ctrl+A/command+A and then F9.

5. If including Supplemental Figures, use the label “Supplemental Figures”. This will 
label it as “Supplemental Figure 1.1”.

Notes:
 Single space each entry. Double space in between entries.
 Maximum 4 lines per entry in the list above. You may have to truncate your entries to 

achieve this.
 The numbering format may be denoted by chapter (1.1, 1.2, 1.3, 2.1, 2.2, etc.) or it 

may be continuous (1, 2, 3, 4, etc.). Format used in list above must be consistent with 
the format used in captions found in the body of the text. This template defaults to 1.1,
1.2, 1.3.

LIST OF TABLES
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Table 2.1: Table caption example. Table captions go above tables. If any caption is more than four 
lines, all captions must be single spaced. In general, we recommend single spacing captions...........26

How to: 
1. The List of Tables is created with the Table of Figures feature and the “Insert 

Caption” button. 

2. When inserting a caption for a table, go to References Tab > Insert Caption. Be sure 
to choose the label “Table”. This will pull the caption into the List of Tables. The 
chapter numbers should automatically generate as long as you use the Headings as 
instructed.

3. To update the List of Tables, click on the table captions above, then click “Update 
Table” near the Insert Caption button. 

4. To update the Table of Contents, List of Figures, and List of Tables at the same time: 
press ctrl+A/command+A and then F9.

5. If including Supplemental Tables, use the label “Supplemental Tables”. This will 
label it as “Supplemental Table 1.1”.

Notes:
 Single space within each entry. Double space in between entries.
 Maximum 4 lines per entry in the list above. You may have to truncate your entries to 

achieve this.
 The numbering format may be denoted by chapter (1.1, 1.2, 1.3, 2.1, 2.2, etc.) or it 

may be continuous (1, 2, 3, 4, etc.). Format used in list above must be consistent with 
the format used in captions found in the body of the text. This template defaults to 1.1,
1.2, 1.3.

LIST OF ABBREVIATIONS

EX Example entry 
EX Example entry
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ACKNOWLEDGEMENTS

Add your personal acknowledgements here and indent the first line of all new 

paragraphs. The Acknowledgements text is double spaced and the text justification should 

match your dissertation text.
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I would like to acknowledge Professor Eta Theta for their support as the chair of my 

committee. Through multiple drafts and many long nights, their guidance has proved to be 

invaluable.

Note: Only the first page of the Abstract has a large top margin of at least 2.5”. 
Keep blank space before Abstract page header.

ABSTRACT 

Text goes here Text goes here Text goes here Text goes here Text goes here Text goes here 
Text goes here Text goes here Text goes here Text goes here 

Keywords: (include 5-6 important key terms from the research study)
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Thesis Title

by
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Name

Master of Science in ……………

University of New York Tirana , 2024

Professor First Last, Chair/Co-Chair (select correct title)
Professor First Last, Co-Chair (if applicable)
Professor First Last, Co-Chair (if applicable)

the 

Add your text here and indent the first line of all new paragraphs. The Abstract text is 

double spaced and the text justification should match your dissertation text. Font size is 10-

12pt. All text must fit within the 1-inch margins.

INTRODUCTION

Add your text here and indent the first line of all new paragraphs. All text is double 

spaced. All text and hyperlinks must be the same font, same font size (10-12pt), and in black 

colored text. All text must be the same justification, like left justified or fully justified. All 

text, figures/tables, captions, and equations must fit within the 1-inch margins.

After your Abstract, the page numbers reset at 1, 2, 3.

Note: Introduction and Conclusion sections are optional. Please work with your faculty 
advisor and committee to determine if these sections are required for your thesis. If you don’t
have an Introduction page, then Chapter 1 would be page 1.
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INSERT CHAPTER TITLE

Add your text here and indent the first line of all new paragraphs. All text is double 

spaced. All text and hyperlinks must be the same font, same font size (10-12pt), and in black 

colored text. All text must be the same justification, like left justified or fully justified. All 

text, figures/tables, captions, and equations must fit within the 1-inch margins.

 

Figure 1.1: Figure caption example. Figure captions go below figures.

The text of the chapter continues here.
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INSERT CHAPTER TITLE

Add your text here and indent the first line of all new paragraphs. All text is double 

spaced. All text and hyperlinks must be the same font, same font size (10-12pt), and in black 

colored text. All text must be the same justification, like left justified or fully justified. All 

text, figures/tables, captions, and equations must fit within the 1-inch margins.

Table 2.1: Table caption example. Table captions go above tables. If any caption is more than
four lines, all captions must be single spaced. In general, we recommend single spacing

captions.

Figure 2.2: Figure caption example. Figure captions go below figures.
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Note: Within the main text, if any one figure, table, etc. caption is more than 4 lines, single 
space all captions. Single spacing all captions are generally recommended.

The text of the chapter continues here. The last paragraph of text should be the 

chapter acknowledgements, if necessary. The chapter acknowledgements paragraph should 

be exactly the same as the corresponding chapter paragraph in the Acknowledgements section

in the preliminary pages.

Chapter 2, in full, is a reprint of the material as it appears in Numerical Grid Generational in
Computational Fluid Mechanics. Smith, Laura; Smith, Jane D., Pineridge Press, 2019. The
dissertation author was the primary investigator and author of this paper.

Supplemental Table 2.1: Table caption example. Table captions go above tables.

Supplemental Figure 2.1: Figure caption example. Figure captions go below figures.
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Notes:
 An APA (American Psychological Association) reference list must:

o Be on a new page at the end of the document
o Contain full references for all in-text references used
o Be alphabetically presented by name of first author (or title if the author isn’t

known, in this case a, an and the should be ignored)
 If there are multiple works by the same author these are ordered by

date, if the works are in the same year they are ordered alphabetically
by the title and are allocated a letter (a,b,c etc) after the date
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